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Welcome

Thank  you for  purchasing  the  X-Pose  Picker  add-on,  the  first  dedicated  multi-platform picker  for
animators and riggers. 

The great effort has been performed in design and development to provide the best quality
and functionality of this software. With X-Pose Picker an artist is free to focus on the artwork and use
effectively  his  time  to  create  even  more  realistic,  complex  animations  of  characters,  machines,
vehicles and creatures.  With its simplicity and integration with 3D Software's  native tools,  X-Pose
Picker is easy in use and ready to start straightaway. 

 



What you get

With X-Pose Picker add-on purchase some exclusive materials  and services are provided:

• X-Pose Picker Blender add-on download access for all available platforms: Mac, Linux and PC

• access to the documentation, templates, examples and tutorials

• easy integration with multiple 3D Software making your picker universal, favorite tool

• Support and lifetime Updates

With buying this add-on you support Blender Foundation through Development Fund
Contribution program and at same time creation of better Software.



Introduction

X-Pose Picker is designed as a universal, multi-platform tool for riggers and animators. It is a
way to select things and control things inside of Blender and other supported software. just like it's
used  in  professional  studios.  With  X-Pose  Picker  you're  able  to  create  layouts  and  control  your
character easier and faster that ever before. Add-on lets you focus on the design, creativity and to
significantly speed up the workflow with extremal learning curve.

The User Manual contains all essential information for the user to make full use of the X-Pose Picker.
This manual includes a description of the picker's user interface, functions and capabilities. It  also
contains advanced techniques, tips and tricks to make the targeted model and animation as easiest as
possible.  However  the  scripting  aspect  of  using  command  buttons  nor  adapting  picker  for  new
software (creating python server plugin) will not be widely covered in this document but some basics
are essential to achieve neat and satisfying results. 

At the end, the documentation describes the list of system known limitations, blind alleys and
explains how to proceed in case of troubleshooting and provides support instructions. 



Main X-Pose Picker features:

• simple but flexible *.xpix file format based on open source software solutions
• powerful, single click x-mirror feature
• full svg vector graphics support for button shapes including x-mirroring
• works with any rig
• copy, paste buttons also between tabs
• tabs duplication
• undo, redo to make errors more forgivable 
• custom keymap
• three button types and 'update button' function
• namespace logic with wildcards for better selection control and work on multiple characters and

complex scenes
• script host execution and embed simple python script editor
• multiple tab projects
• append tab feature allows composition of layouts from different projects 
• highly customizable window layout
• powerful viewport navigation tools
• z-order option for advanced layout creation
• buttons alignment and distribution tools
• cross-platform
• easily reusable pickers for other characters
• easy to integrate with existing 3d software
• left or right mouse button selection 
• auto-focus on host application and auto-move mouse cursor allowing to work on multi-screen

configuration with ease
• generic rig layout templates
• drag'n'drop for xpix project files, backgrounds and svg button shapes 
• automatic script triggering on active tab change.
• at last but not least, can be used as an extra tool for custom UI getting all useful options organized

in one place



Installation for Blender 2.8, 2.9, 3.x and newer

The Installation of the add-on is very simple.  Make sure you have the
latest  Blender  version  available.  Currently  it  is  3.1.2.  The  initial
compatible Blender version is 2.80, 

First of all  download the *.zip  xtrapicker_win, xtrapicker_lin  or
xtrapicker_mac file for your platform (Windows/Linux/Mac). Do not
extract  the  file,  just  remember  its  download  location.  Start  the
Blender program and find the File menu which in the default view is
located at the top left corner of the screen. Select User Preferences.

The another way to get there is by pressing F4, P accordingly (2.8)

Next click the  Add-ons tab
and choose "Install..." button from
the  bottom  of  the  Preferences
Window. 

Navigate  inside  the  file  browser
window and find .zip  add-on file.
Enable it, and unfold the region to
get  more  information  about  the
add-on's current version. 



It  is  possible to check the add-on's  status under the  User and  Animation categories or  by typing
"picker" inside the finding field. By the default add-on should be enabled after installation. 
Finally, at the end make sure that Auto-Save Preferences is enabled, otherwise add-on will be enabled
only on the current session.

Updating the add-on:
Every  X-Pose  Picker  update  is  ready  for  download  from  the  BlenderMarket  after  information  is
announced directly on the product page Changelog. Only bigger updates are notified with an internal
Market e-mail system. In case of troubles with updating your add-on, please uninstall and remove old
add-on from the Blender before installing new one. For more help please contact k44dev Software
support.

X-Pose Picker is now installed and you're ready to go!



X-Pose Picker

The purpose of the X-Pose Picker is to provide set of tools allowing to create picking layouts,
interfaces  for  selection  and  controling  characters  and  3d  objects  at  maximum  fidelity.  Highly
customizable and easy in use at same time is perfect tool not only for professionals but also ones
who's just started their experience with 3D graphics and animation. 

Main motivation is to make X-Pose Picker the tool of choice for riggers and animators on daily basis.
That's why it's designed as a multi-platform program, equipped in simplified python script editor and
easy to implement host server, which gives possibility in the future to use it in 3D Software like Maya,
Unreal Engine or Unity by writting extensions. Easy to share *.xpix file format has been designed with
teamwork in mind. This allows studios to improve their production pipeline from rigging to animating
their CG characters.



Quick Start

Blender:

Select the the character in your 3D Software and set its armature in 'pose mode'.

Locate and go to X-Pose Picker tab in the SideBar. Press 'Picker START' button, status should have
changed from 'disconnected' to 'connected' and Picker should have appeared.

When the armature is active and selected, press 'Set Namespace' from the Picker Panel. 'namespace:'
field should now display active armature's name. Pressing 'Set Namespace' is equivalent to going to
'Picker  >  Change  Namespace...'  menu  in  the  picker  application  and  typing  the  armature's  name
manually. Now picker will link any selected bone with the button when created.

Or, if you have already matching picker preset (*.xpix):

Select the the character in your 3D Software and set its armature in 'pose mode', start the picker from
the SideBar.  In the picker application go to 'File > Open Project...' , choose proper picker preset for
your character. You can also drag'n'drop xpix file to open it. Now if the displayed namespace (below
'Set Namespace' button) matches exactly the armature's name, the picker is ready to work.

Quick Navigation (Mouse buttons at default settings):

• SHIFT + Left Mouse for addtive selection,
• Use CTRL + Left Mouse to select and move buttons in 'edit mode',
• Use CTRL + SHIFT + Mouse for  additive selection in 'edit mode',
• Middle Mouse for panning. Right Mouse for Context Menu,
• ALT + Left Mouse for zooming in.

Hint:
'Blender > Edit > Lock Object Modes' prevents armatures from accidental exitting from 'Pose Mode'.



User Interface

X-Pose Picker Interface  can be divided in few parts: Main menu, ToolBar, Viewport, Tabs, ToolBox,
StatusBar.



Highly customizable User Interface allows to adjust picker for any workflow.

File

New Project:

Every project consists of one or more tabs. This option will create new project. All existing tabs will be
closed and unsaved changed lost. Make sure you save all your important work before you create new
project. 

Open Project:

This will open dialog window allowing to browse for *.xpix picker project files. Opening location can
be  changed  in  preferences  by  setting  Workspace  Directory  option.  Project  file  can  also  be
drag'n'dropped directly to picker viewport to be opened.

Open Recent Project:

Contains a list of recent projects allowing for easy and fast access to recently used layouts.



Save Project:

This  option  by  default,  if  project  name is  not  specified  and file  not  saved on  the  disk,  takes  to
Workspace  Directory  and  allows  to  save  the  *.xpix  project  file,  otherwise  saves  state  of  current
project. (CTRL+S) Saving the file will also save current active tab and all tabs pan and zoom.

Save Project As...:

Allows to save a copy of the *.xpix project file.

Append Tab:

This option lets append tab or multiple tabs from existing *.xpix project to your current project.

Exit Picker:

Closes the X-Pose Picker application. Keep in mind it won't ask you for saving your file.

Edit

Undo:

Undoing back all major changes on current tab including button's scaling, positioning, changing label
text, color, updating, adding, removing buttons and button selection. Keep in mind there is  limited
number of undo steps.

Redo:

Redoing back all major changes on current tab including button's scaling, position, label content, color,
updating, adding, removing buttons and button selection.

Cut:

Cuts selected buttons including all  their properties like size, name, color, position, assignment and
type. 

Copy:

Copies selected buttons including all their properties. 



Paste:

Pastes Buttons and highlights  them.  Buttons can  be pasted on the same tab or  another,  or  even
multiple tabs.

X-Mirror Paste:

Pastes previously copied buttons along Y symmetry allowing to create symmetrical selection panels.
Pasted buttons which are assigned to labeled bones (.L , .l, .left, .LEFT, _l, _Left ...) are automatically
assigned to their opposite bones (.R, .r, .right, .RIGHT, _r, _Right …) . Saves half of the work and half of
the time.  Note  that all  selected buttons will  be duplicated including ones from the center of  the
symmetry.

Select All:

Selects all buttons on the current tab. All buttons in the viewport,  including command buttons are
selected.

Select Inverse:

Inverts selection of buttons on the current tab. Operation does affect command buttons. 

Select Unassigned Only:

Selects all selectable buttons on current tab unassigned to any bones in host program.



Unselect All:

Unselects all selectable and command buttons.

Delete Selected:

Removes selected buttons from the current Tab and updates all their local relationships if there was
any.

Picker

Align:

Align Horizontally:

This will make all selected buttons aligned along horizontal line.

Align Vertically:

This will make all selected buttons aligned along vertical line.

Distribute Horizontally:

Distrubutes selected buttons horizontally with equal distance inbetween.

Distribute Vertically:

Distributes selected buttons vertically with equal space between them.



Buttons:

Add one Button:

adds single rectangular or round button depending on number of elements selected. Button is
added at  last clicked position. Rectangular button controls one single element, where round button
will control selection of multiple character bones. Every selectable button can be promoted to each
type by Updating Active Button.

Add Multiple Buttons:

With this option user is able to add multiple buttons one by one. Once selected in host application in
specific  order will  be added to picker in the same order as armature bones were selected unless
different button will be picked for addition from the list of available buttons.  Pressing and holding
CTRL key enables the ruler that allows to snap and align new buttons at specific angle. It is possible to
end the multiple addition at any time by pressing Escape key.

When adding multiple – press and hold CTRL key for snapping to laser ruler.

Add Command Button:

Adds special, non selectable button which will trigger user defined script inside the host application.
Script can be written and edited by pressind Edit Command Button on the active Command Button.
It's really useful for any commands – from simple like IK/FK switch for your character, making aliases
for most used options, to more complex scripts that may be used not only for animations. To select
Command Button CTRL key must be held.

Edit Command Button:

Opens basic Python Script Editor that allows writting scripts assigned for particular comman buttons
and will be executed directly in the host application when pressing the Command Button. Edit dialog
will  appear only if  Command Button is  selected.  Get  some examples  from Mike and Anna *.xpix
templates. Command button code can be executed automatically on tab change when auto-execute
option is selected. Execution order is set by button adding ordering.

Update Active Button:

By using this option it is possible to refresh the button's relationship list and its type. Round button
may be promoted to rectangualar button and vice versa. If there is a need to change assignment for
the particular button just simply select all the elements that are needed to be linked (bones or other
buttons), select the button that has to be updated and press Update Active Button.



Change Button Shape:

Replaces selected button(s) shape with svg image. Svg images can also be drag'n'dropped to buttons. 

Rename Button:

Changes labels for all selected buttons. ToolBox must be visible.

Increase/Decrease Button Size:

Changes size of all selected buttons making them bigger or smaller.

Normalize Button Size:

This will make all selected buttons equal size based on average.

Z-Order:

With changing Z-Order it is possible to move one elements above or below the others the same way
like they would lie on layers. If  one button is cover by another, simply bring it to the top with no
struggle.

Tabs:

Tabs  are not only helping organise things  visual  in particular  context  but  also are responsible for
managing  what  objects  and  characters  are  being  controlled  on  the  scene.  Each  tab  has  own
namespace assigned to itself and unique set of properties like own undostack, name, etc.



New Tab:

Adds new tab to current project. Default namespace and unique name are set.

Duplicate Tab:

Duplicate Tab will create new tab and copy all the buttons, their assignments, settings and properties
including namespace for this tab.

Rename Tab:

This will change the name of currently active tab. This does not affect namespace nor other settings.

Close Tab:

Closing the tab will remove it from existing project. This operation can not be undone.

There's also a way to append existing tabs from other projects with Append Tab option from the File
menu.

Unselect all on Tab change: 

When enabled picker and Blender selection will remain clean on any change of active Tab.

Change Background:

Select the background for your tab with Change Background option. Open File Dialog by default starts
with default workspace location. Accepted images jpeg, png, svg. Image files are written into project
file when saved. It's handy feature for sharing templates but  large images may increase project file
size. Picker *.png background supports transparency (alpha channel). Changing background can also
be done by mouse drag'n'drop function.

Clear Background:

Removes background from the active tab and from the project file.



Change Button Color:

Changes button color for selected buttons. This menu option opens system color picker which allows
to  use  system color  palette  or  pick  the  color  from the  screen.  Capabilities  depend on  operating
system. Selected color will also be used for adding new buttons.

Change Label Color:

Changes label color for selected buttons. This menu option opens system color picker which allows to
use system color palette or pick the color from the screen. Capabilities depend on OS used. Selected
color will also be used for labeling new buttons.

Unlock Namespace:

Useful when animating  multiple characters or objects  at the same time.  Usecase: crowd, dynamic
scenes with multiple generic rigs and so on. Unlocking namespace will allow to control any active rig
as long as its bone's naming matches the template bindings in the picker's tab. For example if there
are three characters that are using exactly the same rig they may be controlled using just single set of
buttons on one tab instead using three different tabs. X-Pose Picker gives freedom of work style and
workflow.

Change Namespace:

Manual equivalent of Set Namespace in the Host program. Specify the namespace (Armature name)
that  will  be  used for  the  current  Tab.  Each  tab  in  the  project  has  its  own namespace  assigned.
Namespace can use wildcards '?','*' to replace single sign or multiple signs accordingly.



Preferences:

workspace directory:

For convenience, set it to most popular location. Workspace directory will  make dialogs like Save,
Open, Change Background, Append, etc. start browsing from provided location. This will save some
time on browsing directories.

Default namespace:

This will set defined namespace for each new project. Namespace by its defaults is empty („”)

Autofocus Host program on transforms:

When enabled, automatically focuses host window reducing number of clicks needed to animate 3D
character (MS Windows only). This option is required for key shortcuts to work in Host Application.
Keep it enabled for shortcuts passthrough.

Auto-cursor to Host on transforms:

When enabled, automatically focuses host window and moves mouse cursor from picker to the host
program  on  Move,  Scale  and  Rotate,  and  brings  it  back  to  picker at  the  end  of  operation  (MS
Windows only). This can be handy when working on dual-screen setup and having picker on different
screen than 3D app. Saves a lot of mouse movement making work significantly faster.

Return Auto-cursor to Picker on transforms:

Automatically brings back mouse cursor to picker when enabled. (MS Windows only)

Flip mouse buttons:

Enables  Context  Menu under  Left  Mouse button and moves all  selection  options  to right  mouse
button. Useful customization for old-school Blender Users. Unchecked by default.

Super-focus:

Will keep your picker window focused on mouse hover when this option is enabled.



Custom Keymaps:

Change keymaps to match your style and workflow. With version 1.7.6 more keys  assignments are
editable. Go to preferences>Custom Keymaps and enable the option. Be very careful when creating
custom shortcuts. There must not be two or more identical shortcuts assigned.

View

Pin Current View:

Temporarly stores current viewport's  zoom and position. Allows to restore the zoom and position
when resetting the view. Active as long as Pin Current View is option is enabled.

Reset View:

Brings back the view to its default state or if  Pin Current View is enabled, will  restore viewport's
pinned zoom and position. 

Frame View to selected:

Zooms in and centers the view to selected buttons. Useful for precise operations.

Go to Tab:

Provides a list of all available tabs. Alternative way to naviagate around tabs.

Stay on Top:

Stay on Top will make your picker be visible over all other windows. This option will not be visible on
Linux, which  is supported  natively by  application  window  (gnome  window  manager).  For  Linux
platform use 'Always on Top' option on window title bar context menu instead.

Unhide All:

Unhides the Icon ToolBar Menu, Toolbox, window decoration frame, StatusBar.

Hide ToolBar:

Hides the Icon ToolBar Menu, used for better space arrangement.



Hide ToolBox:

This option will hide button color picker, button size, button Label text field and label color picker.
Note that with ToolBox hidden it's impossible to name and rename buttons.

Hide StatusBar:

Hides part of the window where hints for options are displayed.

Hide Window's Frame:

Hides application window's decoration for more compact view. For technical reason this may disable
Stay on Top feature on Linux.

Script Editor:

Opens basic Python Script Editor that will  execute typed scripts directly in the host application, if
supported.  This  useful  function  allows  to  create  advanced  custom  commands  triggered  with
Command Buttons. Script Editor will open only for active Command Button.

Help

Online Manual:

Provides a link to online resources, including this document, tutorials and examples.

Visit Website:

Forwards to k44dev website.

Get More Scripts:

Get more scripts, add-ons, tools and templates from k44dev website.

About:

Includes information about the picker, like program version, framework used, etc.



Viewport Navigation
Navigating through tabs makes the work easier and more organized. It's possible to  drag and drop
tabs to sort them and scroll between tabs with mouse wheel.

Within the viewport it's possible to  pan by holding  middle mouse button, zoom with  mouse scroll
and  rubberband zoom to selection region while holding ALT.  Zoom can be  reset with ALT + double
mouse  click.  View can  be  reset with  selecting  option  from  te  menu  View>Reset  View  or  using
CTRL+SHIFT+F shortcut.  Restored View  will  be set to stored  position and zoom  when  Pin Current
View is active.

At last but not least selected objects can be zoomed with  Frame Zoom to Selected from menu or via
shortcut SHIFT+F. If there is no any selected objects in the viewport, SHIFT+F will reset the zoom stack.

ALT + Double Click – will reset the zoom stack.

MOUSE WHEEL – zoom in and out. Hold SHIFT or CTRL for faster or slower zooming accordingly.

Buttons are selectable with left mouse click by default, except command buttons which pressed, will
trigger script on host application. Button selection can be switched from LMB to RMB in preferences
with Flip mouse buttons option. This will also switch context menu call.

Press and hold for left mouse button:

rubberband selection – will select all selectable buttons inside the selection region. Button selection
resets on every new selection attempt.

with SHIFT  –  works  as  additive,  preserves  the selection  and will  flip  the selection for  buttons  in
affected region (applies also for clicking).

with CTRL  - Selects buttons without triggering any action in 3D host application. Allows selection of
Round Button  without  selecting  its  children.  Useful  for  editing.  Clears  buttons  selection on each
attempt. (applies also for clicking).

with  SHIFT+  CTRL  adds  to  selection  however  will  not  trigger  any  action in  3D  host  application.
(add/remove to selection when clicking).

ALT – when held, will zoom to rectangular selection region. 

Hint:

Closing the picker with window close button (X) or by File > Exit Picker will remember its window
position and size.



Context Menu

Context Menu contains most popular actions. It can be triggered with Left or Right mouse button
depend on chosen preferences. Add, remove, update or align/distribute buttons actions are available
as well as edit script for command buttons.

ToolBar

Toolbar contains popular shortcuts for file, undo/redo, background, preferences etc. Can be moved or 
hidden.

ToolBox

ToolBox contains popular button properties – button color, button size, label text and label color. 
ToolBox can be hidden or displayed in View menu. Note that toolbox must be enabled for some 
actions.

Button and Label Color Picker

Displays basic color palette for button and label. Right click on the color button itself will set current 
color for all selected buttons.

Button Size

Changes size for all selected buttons. This change affects all new buttons which will be created with 
this setting applied.

Button Label

Sets label for all selected buttons. All new buttons will be created with the set label.

StatusBar

Shows useful tips. Can be disabled in View menu.



Host Options

This chapter describes all the options across supported hosts.

Blender

Host Panel

Picker OPEN/CLOSE:

Starts/Stops the picker program. Connected status means all in good shape.

Set Namespace:

When pressed, automatically sets the namespace of active armature for the current, active tab in the
picker.  Active armature has to be set in pose mode.

Link Viewport: 

Makes current 3D View active view for the Picker. If you work with multiple 3D Views you can choose
which one will be used by picker's Auto-cursor tools.

Gizmos on transforms:

will  display  LocRotScale  gizmos  inside  Blender  instead  triggering  modal  transforms  when  using
shortcuts for rotating, moving and scaling. Works only when Auto-focus is  enabled. To enable Auto-
focus go to Preferences in Picker application.

File Autoload :

Open a file browser for setting the xpix projech which will associate with currently used blend file. This
will open the picker with automatically loaded the xpix project at its start.

Host Preferences

Status:

Status  describes  communication  between  host  application  and  the  picker.  Two  states  –  can  be
connected or disconnected. 



TCP Port: 

If everything works do not change this setting. 

Default port is set automatically. In case of troubles with communication between host application
and the picker, which may be caused by other application stole the port,  change the port to first
unused and check the internal firewall settings. 

Debug Mode: 

enables extra printing log files in add-on folder. Use it only for troubleshooting.



Troubleshooting

When having an issue please contact support to obtain debug version of the picker which will be able
to generate picker log files.

Start with blender console, look for python errors.

Look for errors and warnings in the console.

Prepare  simple  scene,  reproduce  and  define  an  error.  Collect  logs,  contact  Support,  write  error
description with blend file and specification details provided.

Known limitations:
• By default one instance of picker is allowed. 
• Color picker functionality used for Changing Color options may vary depending on operating 

system.
• Stay on Top feature may not work with specific Linux System window managers when window 

decorations are disabled (Hide window's Frame). GTK and KDE are recommended.

Known issues:
Add-on after installation on Linux and MacOS may require manual fixing the binary permission to
executable.
/bin/sh: /Users/username/Library/Application Support/Blender/2.81/scripts/addons/xtrapicker/XtraPicker/XtraPicker: Permission denied

This is actually related to Blender’s add-on installer which under Linux and MacOS removes file attributes when installing the add-on to Blender add-on’s 
location. One of removed file attributes is file execution attribute which prevents the picker from starting.

There’s a workaround for this. In the terminal/system console use the modified command below 
which follows the add-on’s binary path (MacOS example):
chmod a+x ~/Library/Application\ Support/Blender/2.xx/scripts/addons/xtrapicker/XtraPicker/XtraPicker

Some AntiVirus Software may generate false-positive alerts. Please report this issue as false-positive
at your AV software provider's web-page form, upload the whole xtrapicker_xxx.zip add-on archive.
Please also report it to  karab44@wp.pl 

In the AV web-page form describe the software as :

„X-Pose Picker is a program which helps animating digital 3D characters used in pair with 3D Software.
It's  built  with  Python 3.7  on  top  of  Qt  Framework  and  it's  using  TCP/IP  localhost  via  asyncio  to
communicate with this 3D Software in a client-server application fashion. This particular version of the
program requires Blender 2.8 3D software to install however executable can be launched standalone.

The program works totally offline, does not contain any advertisement system, does not collect
any system or user information and does not require connection to the internet.”

mailto:karab44@wp.pl


Technical information

Messaging:

Communication between the picker and 3d host application  relies on asyncronous TCP connection.
For example, Blender is using python's asyncio which guarantees portability across all used platforms.
Messages are passed between applications as simple json data what makes them easy to read and
interprete in case of debugging.

File format:

*.xpix file format data is stored as *.zip compressed archive containing simple json text and image files
what makes them easy to read and interprete in case of debugging. Each json data structure contains
information about tabs viewport, its background, buttons, their properties, svg and their assignments.

Framework:

The latest X-Pose Picker version is build on top of Qt 5.12.x Framework for 32-bit  Python3.7 also
known as PySide2. Thanks to the used technology portability between platforms is a rather smooth
process and allows to run X-Pose Picker on almost any hardware and system.

Blender 2.79:

Only initial versions of picker worked with Blender 2.79 and is no longer supported. To make add-on
work on older version of Blender, change the version number inside __init__.py python file of the add-
on from 2.80.0 to 2.7.9. to make Blender recognise the add-on. However to run the server correctly
also change to server scripting is required which may occur difficult. Note that using the picker with
Blender 2.79 and older is not officially supported.

Debugging:

Contact developer for the support and eventually special debug build.



Support

In case of software issues, feedback, feature request or licensing questions please contact k44dev
Software developer at karab44@wp.pl or via website:
https://blendermarket.com/creators/k44devsoftware 

https://blendermarket.com/creators/k44devsoftware
mailto:karab44@wp.pl


Reference links

https://blendermarket.com/creators/k44devsoftware

https://www.youtube.com/k44devstudio

https://www.facebook.com/k44dev 

https://twitter.com/k44devStudio 

https://blenderartists.org/

https://k44dev.com

https://k44dev.com/
https://blenderartists.org/
https://twitter.com/k44devStudio
https://www.facebook.com/k44dev
https://www.youtube.com/k44devstudio
https://blendermarket.com/creators/k44devsoftware


Notice about the Licensing:

Copyright (C) 2022 k44dev Software

The customer called also the user after purchasing the product becomes the user of this license. This
is a single user license and can not be redistributed or moved to any other person. Any support,
documentation, tutorials and software update service provided to the user are covered by this license.
The license doesn't mix with other used licenses. 

Notice about this document:

Copyright (C) 2022 k44dev Software
Created by Albert Makać

All the third-party signs, brands and other third-party content used within this document if any, 
belong to their owners. 
Special thanks to Artell, the creator of Autorig Pro for providing Anna and Mike Rig for this 
documentation, presentation and supporting development of X-Pose Picker!

Notice about the Software Licensing:

Copyright (C) 2022 k44dev Software
Created by Albert Makać

This program is free software: you can redistribute it and/or modify it under the terms of the GNU
General Public License as published by the Free Software Foundation, either version 3 of the License,
or (at your option) any later version. This program is distributed in the hope that it will be useful, but
WITHOUT ANY WARRANTY; without even the implied warranty of MERCHANTABILITY or FITNESS FOR
A PARTICULAR PURPOSE.  See the GNU General Public License for more details.

You should have received a copy of the GNU General Public License along with this program. 

 If not, see <http://www.gnu.org/licenses/>.

http://www.gnu.org/licenses/
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